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TutorialGIMP

ART AND IMAGE EDITING

he GNU Image Manipulation Program, better know as The

GIMP, is the premier interactive image processing

application for the Linux operating system. Its user interface

is based loosely on the popular Adobe Photoshop image

editing package. But while Photoshop provides a long, dual-column

Toolbox with multiple pop-up menus, a cluttered menu bar, and an

enclosed workspace, The GIMP provides a simplified Toolbox and

menu bar, a free floating workspace, and sophisticated Canvas

windows with tear-off menus.

The GIMP provides many of the same features as Photoshop,

from layers and paths to blend modes and text manipulation. It

also provides features not found in Photoshop, including support

for multiple scripting languages which makes GIMP perfect for

web based animation production.

GIMP’s flexibility and easy to understand interface, coupled

with its sophisticated plug-in API, scripting languages and open

source license has made it an integral part of the motion picture

special effects industry.

The GIMP interface
The main window for the GIMP is called the Toolbox. The tools

should be familiar to Photoshop users, though the layout of the

window is slightly different. First, individual tool buttons are not

pop-up menus on their own. Double-clicking a tool button in the

GIMP opens a Tool Options dialog which allows you to change the

behaviour of the tool. This helps reduce the complexity of the

tools by allowing them greater flexibility for a single tool instead

of providing multiple tools that do similar things. 

Next, the concept of Full Screen is irrelevant with the GIMP –

PART 1 The GIMP is the grandfather of the Linux/GNOME
desktop environment. Michael J Hammel’s quick tour will
get your started using this popular image editor.

The GIMP User
Environment
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since the workspace is open (not constrained by the application)

it is possible to move and resize windows at will. Iconifying the

GIMP will only affect the Toolbox itself, not the other windows.

However, a quick way to hide all the windows is to press the Tab

inside a Canvas window. This will cause GIMP windows to be

hidden. Because of the unconstrained nature of the GIMP’s

interface, there are no icons on show in the Toolbox for setting

the application display size like the ones that inhabit the bottom

of the Photoshop window.

Finally, menu options in the GIMP that create new images or

modify existing ones can apply either to the active Canvas

window or to a new Canvas window. The concept of an active

Canvas window is sometimes hard to grasp for new users of

GIMP. One of the most common questions is “Where are the

Filters?” Each Canvas window has its own menu, accessible from

the menu button in the upper left corner of the window or by

holding down the right mouse button inside the window.

GIMP:
http://www.gimp.org
GIMP Registry:
http://registry.gimp.org/in
dex.jsp
Graphics Muse Tools CD:
http://www.graphics-
muse.com/gfxmuse/gfxm
use.html
Tutorials and other useful
links:
http://www.graphics-
muse.com/cgi/gmcat.pl?i
d=11

URLs
Online GIMP
resources

>>

The working environment of The GIMP. Starting at the upper left: the
Toolbox, a Canvas window, the Layers and Channels dialog, the brushes
dialog, the Tool Options dialog and a tear off Filters menu. A typical GIMP
session often has multiple Canvas windows opened, along with the Layers
dialog. The brushes, patterns and gradient dialogs can be left open, or
closed and quickly recalled using respective active buttons in the Toolbox.

The brushes dialog offers access to standard grayscale brush shapes,
coloured brushes and Brush Pipes. Brush pipes offer artists brushes with
multiple shapes, any of which can be imprinted on the Canvas window
depending on direction, speed and even pressure applied by the paint
tool. Predefined patterns can be easily saved using the ‘.pat’ file format.
Gradients can be created and edited using the Gradient Editor.
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The File and Xtns menus
GIMP’s Toolbox provides three menu choices – File, Xtns and Help.

While the purpose of Help is fairly obvious – links that launch web

browsers to online documentation and other useful sites – the

purpose of Xtns may not be. In fact, it’s commonly asked how

these menus relate to the Canvas menu.

If you’re used to Photoshop, one of the first hurdles to

migrating to the GIMP will be understanding the active Canvas

concept. Menu options for any menu are either associated with

the current active Canvas window or are independent of any

Canvas window. This means that menu options that render new

images will either do so in the currently active Canvas window or

in a new Canvas window. 

The Xtns menu provides options that are not dependent on

any open Canvas window. The menu is divided into two parts. The

top portion provides options that are more plug-in and script

developer oriented. These include the DB Browser and PDB

Explorer for searching for plug-in API information and the Parasite

editor for adding annotations and other useful text information to

images. The lower half of the menu includes tools for rendering

logos and buttons as well as managing the Perl server. 

Few of these options are ever used by the average desktop

GIMP user, though power users will find the DB Browser useful.

Additionally, many of the options shown are not part of the stock

GIMP distribution. They are added by additional plug-ins which can

be downloaded from the GIMP Registry, various web sites around

the world, or acquired from the Graphics Muse Tools CD, a

commercial package of over 100 prebuilt plug-ins.

TutorialGIMP
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SANE
http://www.mostang.com
/sane/
XSANE
http://www.xsane.org/
Vuescan
www.hamrick.com
Image Scan!
http://www.epkowa.co.jp
/english/index_e.html
QuiteInsane
http://quiteinsane.sourcef
orge.net/index.shtml
Epson KOWA
http://www.epkowa.co.jp/
english/linux_e/lsd_e.html
Linux USB Project
http://www.linux-usb.org/

Scanner
support
Where to get your
drivers

Layers Menu
One of the most difficult concepts new users have to conquer is

the use of layers. A layer is like a transparent acetate sheet that

you paint on. Each sheet is combined in different ways – called

‘blend modes’ – in order to generate the composited image.

Layers have many features and can be moved, resized, and raised

and lowered in the stack of layers. The Layers Dialog is used to

manage layers and most users will find they have this window

opened nearly all the time.

A feature used extensively in large portrait designs is the layer

mask. A layer mask blocks out sections of a layer. Light areas of

the mask allow the corresponding part of the layer image to

show through while dark  areas of mask block out corresponding

sections. Masks allow you to combine layers in without modifying

their contents. This permits a single image, duplicated a number

of times to create multiple layers, to be used with different blend

modes using different parts of the image without change the

original image.

The File menu is
where you’ll open
existing
documents or
create new
Canvas windows.
You can also
configure GIMP
directories and
various
behaviours using
the Preferences
dialog. If you have
scanner plug-ins
such as XSANE or
QuiteInsane they
would appear
under the Acquire
submenu here.

This is the catch-all menu for plug-ins that
don’t quite fit anywhere else. Many of these
tools are script based, either Perl or Script-
Fu. The most useful of these are not included
in the stock GIMP distribution, such as the
Web gallery tools and the animation and
video tools. But most can be downloaded
from the GIMP Registry.

You’ll find you
use the Layers
and Channels
dialog often,
mostly on the
Layers tab. The
Channels tab is
used by more
advanced users
to work in a
single colour
channel to
create selections
or to save a
selection as a
new channel.
The Paths tab is
used to create
line drawings
that you can
later convert
into selections
or outline using
the Edit>Stroke
option of the
Canvas Menu.

Managing Layers requires the use of the Layers menu. This
menu can be accessed by right-clicking on any layer. Layer
management includes four basic functions: creating and
deleting, changing the stacking order (including merging
layers), managing the alpha channel, and managing the layer
mask. A simplified Layers menu is offered in the Canvas
menu that will also allow to align layers edges and centers.
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The Canvas Window
The Canvas window is where all your image editing takes place.

When you open an existing image, it is displayed as a single layer in

a Canvas window. You can edit the first layer – which is called the

Background layer by default, or create new layers and edit those. 

A canvas consists of rulers along the left and top sides of the

drawing area, modifiable guide lines that can be pulled from the

rulers (hold down the left mouse button and drag from one of

the rulers), scrollbars on the right and bottom of the drawing

area, a status bar along the bottom of the window, Quick Mask

buttons on the lower left and an Image Navigator button on the

lower right. The Image Navigator looks like the Move tool icon

and allows you to scan around your image if it happens to be

larger than the Canvas window currently displays.

Every canvas has its

own Canvas menu. To

open this menu, hold

down the right mouse

button in the image area.

The menu offers you a

variety of options, from

saving the file, to

modifying existing

selections, to applying

filters. This is a tear off

menu, which means if you

click on the dotted line at

the top of the menu it will become a window of its own that stays

open until you click on the dotted line again. All submenus of the

Canvas menu are also tear off menus, which means, for example,

you could tear off the Filters>Blur submenu to have quick access

to the multiple blur filters without having to traverse multiple

higher level menus.

In the coming months
we’ll be offering a series
of tutorials showing how
this tool can be used for
both the mundane and the
sophisticated. In this first
tutorial, we’ll take a quick
run through the windows
and dialogs provided to
help learn your way
around. From here on,
we’ll assume a basic
knowledge of menus and
use of the Toolbox and
Canvas windows. If you
need more detailed
information you can check
out the online GIMP
reference guide – the
GUM (GIMP Users Manual).

NEXT
MONTH

Grokking The GIMP, Carey
Bunks, New Riders ISBN: 0-
7357-0924-6
GUM – GIMP User
Manual, Kylander and
Kylander, Coriolis; ISBN: 1-
5761-0520-2 (also online
at GIMP.org)
GIMP for Web
Professionals, Hammel,
Prentice Hall ISBN: 
0-1301-9114-0

Treeware
Books on The GIMP

What’s Missing
While The GIMP offers many of the same features Photoshop users

have grown to appreciate, there are still a few missing from this

Open Source alternative. The most important of these is proper

colour management. The GIMP does not currently support true

CMYK colour management. In fact, it only works in Grayscale,

Indexed and RGB colour spaces. Additionally, colour channels in

The GIMP are limited to 8 bits. These two issues combine to make

GIMP less than optimal for print work. Still, if absolute colour

matching is not an issue, GIMP can – and does – provide many of

the tools necessary for exceptional artwork bound for the Web, in

print or in the video industry. LXF

A Canvas window displays the composite image, but it does
so based on the settings for the individual layers that
comprise the complete image. The Canvas menu is opened
by clicking the left mouse button on the arrow button in the
upper left corner of the Canvas window or by holding down
the right mouse button anywhere inside the Canvas
window. When moving an existing Guide Line, be sure to
have the Move tool active in the Toolbox. You can instantly
resize the Canvas window to fit your image by pressing Ctrl-
E inside the drawing area of the window.

This menu is used more often than the menus in the
Toolbox, so tearing it off to make it a window on its own is
probably a good idea. The Script-Fu submenu has an option
called “Shadow”, which includes an easy to use drop
shadow filter. The options shown in the Filters menu here do
not all come with the basic GIMP installation. Many require
you to download, compile and install them manually, or you
can purchase prebuilt versions on CD.

There are many
filters freely
available for
GIMP, though not
all come with the
basic distro. The
menus make
sense for the
most part – eg
the Blur submenu
provides filters
that blur, the
Distorts submenu
provides filters
that twist, flip
and otherwise
mangle an image
and the Light
Effects render
lens flares and
white light effects
on an image. 

Script-Fu is one of a
number of scripting
languages supported by
The GIMP. This menu
provides a filters which
have been written in this
language. In essence
there isn’t any reason to
differentiate these filters
from filters written in
Perl or in any other
language. For the short
term, just remember this
is where you’ll find your
drop shadow filters!
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